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1 Overview of the Multi-channel analyser system

The software comprises three parts:

• The server which should run all the time in background. It may be started at system startup.

• The control program which is used to configure the channels, to start and stop runs and to read the
spectra from the MCA2.

• The viewer program which is used to visualise the spectra and save them to disk.

2Multi-channel analyser
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2 The MCA server

There are three versions of the server which communicate with the MCA in different ways.

• mca server outb - uses direct I/O on the parallel port. This is the fastest way to access the parallel
port, but doesn’t work on some newer computers.

• mca server ppdev - uses the ppdev device to access the parallel port. This is slower than outb but
should always work.

• mca server usb - use this if the MCA is connected via USB.

Other than the way they communicate with the hardware, the three kinds of server are identical.

The server is started with the command:

mca server outb

(or one of the other two, as appropriate) and it should simply run. It runs in privileged mode (i.e. it must
be installed SUID root - this is so that it can switch to user “nobody” for file writing, to prevent it from
clobbering files) and communicates via the parallel port of the PC directly with the MCA unit. It reads
commands from a named pipe (/usr/lib/mca server/mca stdin) and writes responses to a different named
pipe (/usr/lib/mca server/mca stdout). It can either be started up from the command line or during system
startup, or from an icon.

There is nothing for the user to configure and no options for the server.
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3 The MCA acquisition control program

3.1 The main window

Figure 1: The main window of the acquisition control program.

The control program is started with the command:

mca control

The main window (see figure 1 shows at the top the version of the firmware installed on the MCA and the
serial number of the unit.

In the middle of the window, it shows the counters and rate meters. The “Live time” is the time that the
device is actually acquiring, not including the time taken for readout etc. The “Real time” is the time
including dead time. The column marked “Triggers” indicates the number of times per second, a signal was
detected by the MCA, while the “Events” column indicates the number of times per second one of these
triggers was actually processed. A trigger is generated whenever a signal goes above the threshold, which
the user set. In order for such a signal to be processed, the acquisition must be running and, if a coincidence
or anti-coincidence is required, this condition must also be fulfilled.

The next part of the window has the buttons to start acquisition, stop acquisition, clear the spectra and
counters or to quit the program. You do not need to stop the acquisition in order to clear. The keys F2, F3
and F4 may be used as shortcuts for start, stop and clear respectively. There is also a spin box to set the
period in seconds at which the spectra are read out. Setting this value to zero turns off this readout.

Below that are two buttons to pop up the configuration windows for each channel (see section 3.2).

The last line has a spin box to set the time limit in seconds for timed measurements. This value is compared
with the live time and the acquisition is stopped when the live time reaches this value. If the value is zero,
this option is disabled.

Finally, there is an initialise button, which needs to be pressed once, after the MCA is first powered up.
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This sets the parameters to the correct values.

3.2 The channel configuration windows

Figure 2: The window for configuring channel 1 of the acquisition control program.

The channel configuration windows (one for each channel) are called up by pressing the corresponding button
“Configure channel 1” or “Configure channel 2” in the main window.

In this window, there are sliders to set the zero level discriminator, the lower level discriminator, the offset,
the ramp of the ADC, the gate generator delay and the gate generator width. These last two sliders are
inactive is gating with the gate and delay generator is turned off.

It is possible to invert the clock of the ADC, so that we consider the trailing edge of the clock pulse rather
than the leading one. This can help if there is electronic noise, which is disturbing the clock, but shouldn’t
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be changed otherwise.

There are other settings, such as the ADC clock rate and the number of samples, which can be changed at
hardware level, but which should not be changed. For this reason, they are greyed out, so the user cannot
change them.

It is possible to set the number of bins (“Nbins”) in each spectrum. Legitimate values are 16384, 8192,
4096 and 2048. Having more bins gives better resolution, but less events per channel. Note that the ADC
ramp should be set appropriately for the number of bins. When the number of bins is set, the ramp is
automatically changed to an appropriate value.

The singles “Enabled” button turns the channel on or off. Unless it is enabled, the channel is
not read out, though this doesn’t prevent it from acquiring.

The “Gated” button turns on and off the gate. If gating is turned on, the gating can either be a coincidence
or anti-coincidence and the next button “Coinc” determines which. Finally the fourth button in that row
marked “DGG” selects the mode of operation of the gate. If DGG is turned off, the gate signal is used
directly as a gate. If DGG is on, only the leading edge of the gate signal is used to start a gate and delay
generator. This is delay and width are set by the two sliders “Gate Generator Delay” and “Gate Generator
Width”, which are only active if this mode is selected.

Last of all, the finish button, closes the window. Note that the values are sent to the MCA whenever a slider
or button is changed, not when the finish is clicked. All the finish button does is to hide the window.

3.3 The spectra

The spectra are written periodically to disk, the period being specified by the period spin box in the main
window. They are written in two-column ASCII format (channel number and counts in channel) with a four
line trailer at the end giving the trigger rate, event rate, real time and live time.

The files are:

/tmp/mca 1.spa

and

/tmp/mca 2.spa

for channel 1 and 2, respectively. They may be viewed using the viewer program (see section 4).
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4 The MCA viewer program

4.1 Invoking the viewer program

To view the current spectrum for channel 1:

mca viewer /tmp/mca 1.spa

To view the current spectrum for channel 2:

mca viewer /tmp/mca 2.spa

To view another spectrum:

mca viewer filename

Or you can start the viewer without an argument and use the open option in the file menu (see section 4.4).

4.2 Overview

Figure 3: The main window of the viewer program. Note that the colours have been inverted to save printer
ink, when this document is printed.

The main window has three parts to it:

• The status lines.

• The lines for the regions of interest (ROI).

• The spectrum.
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The first status line shows the current position of the mouse pointer in terms of channels and counts, the
corresponding energy of that channel and the number of events in that channel of the spectrum.

The second status line gives the name of the spectrum and the total integral.

There is one ROI3 line for each ROI defined and they are colour coded. Each ROI line gives the integral
of the region, the mean position in channels and energy, the maximum of the region and the channel and
energy at which the maximum occurs.

Finally, most of the window is occupied by the spectrum itself. The lower x-axis is in channels, the upper
x-axis (if calibrated) is in keV. The y-axis is in counts. Regions of interest are highlighted in different colours.

4.3 Marking a region

Many of the operations such as zooming in, setting a region of interest or fitting a peak, require a pair of
limits. In order to set a pair, use the following procedure:

• Move the mouse pointer to the left of the region and press the left mouse button down.

• Still holding the left mouse button down, drag the mouse pointer to the right side of the region.

• Release the left mouse button.

4.4 File menu

Figure 4: Part of the main window of the viewer program showing the file menu.

The acquisition writes the spectra to disk, but with a fixed filename, so they are always overwritten. In
order to be able to record spectra, you need to be able to save the spectrum under another name and
open it again. The “File” menu has the options to do this. From here you can select options to open a new
spectrum, close the current spectrum, save the current spectrum under a particular name or quit the program.

If you use the “Save” option, without having previously used “Save As”, you will be prompted for the file-
name. If you have set a name in this way, or using the “Save As” option, this name will be used. If the file
exists already when you are prompted, you will also be prompted as to whether you wish to overwrite it or
not. If, however, you use “Save” a second time, it will overwrite the first file without prompting.

4.5 View menu

Usually, it is desirable to view specific parts of the spectrum, change the scale, or select logarithmic repre-
sentation. These options are available from the “View” menu.

Options such as “Set E limits by energy”, “Set X limits” and “Set Y limits” prompt the user for the limits.
These should be entered separated by a space.

3ROI = region of interest
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Figure 5: Part of the main window of the viewer program showing the view menu.

Options such as “Autoscale” and “Linear/Logarithmic scale” have sub-menus, where the user can select
different options. For the autoscale option, the autoscaling can be turned off, set or set to one of nine ranges.
Range “1” means that the y-range will be set so that the channel with the greatest number of counts in the
displayed x-range, will fit exactly onto the screen. “2” means that the lower half of the peak will be visible,
“3” means the lower quarter is visible etc. For the linear/logarithmic option, it is possible to select one of
the four combinations of x and y logarithmic and linear.

The options “Shift spectrum to the left by 1/3”, “Shift spectrum to the right by 1/3” and “Zoom in on
marker” all require a single marker. Such a marker can be set by clicking with the left mouse button prior
to selecting the option.

Prior to calling the “Zoom between markers” option, a region must be set (see section 4.3).

4.6 Spectrum menu

Figure 6: Part of the main window of the viewer program showing the spectrum menu.

The “Spectrum” menu provides operations on spectra.

The “About spectrum” option pops up a window giving various information about the spectrum and its
regions of interest. If it is an acquisition spectrum, the values of live time, real time, trigger rate and event
rate can be read here.

The “Calibrate spectrum” option pops up the calibration window (see section 4.9).

The “Fit peak between markers” option allows you to fit a peak. You must define a region (see 4.3) first
with limits on either side of the peak. Note that if your region is very large, fitting will be very slow. It
must, however, include the whole peak. The results are written to the log window, which pops up if it is not
already visible (see section 4.10).
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Note that the fit is displayed graphically as well. To remove the fit from the spectrum select the “Hide the
fits” option from the ROI menu (see section 4.7).

The “Integrate between markers” option allows you to integrate the spectrum over a region. You must define
a region (see 4.3) first with limits on either side of the region. The results are written to the log window (see
section 4.10), which pops up if it is not already visible.

The “Operations on spectra” option is used to add and subtract spectra (with multiplying factors). A widget
for adding and subtracting pops up when this option is selected. See section 4.11.

The “Postscript plot” option is used to generate a PostScript file (suitable for printing to a PostScript
printer) containing a plot of the spectrum. The user is prompted for the filename.

4.7 ROI menu

Figure 7: Part of the main window of the viewer program showing the ROI menu.

It is usually necessary for the user to define regions of interest (ROIs) containing the peaks, which are of
particular importance, or for background regions. The integral, mean position and maximum position of
each ROI is displayed at all times in the ROI box of the main window, so this is particularly useful for fast
comparisons.

To add a region of interest, define a region (see section 4.3) and then select the “Add region of interest”
option from the ROI menu.

To delete a region of interest, define a region containing the ROI to delete (see section 4.3) and then select
the “Delete region of interest between markers” option from the ROI menu.

To delete all the regions of interest select “Delete all regions of interest” from the ROI menu.

Rather than fitting peaks individually, it is often useful to define a region of interest for each peak and
than select “Fit all regions of interest”. This is equivalent to marking a region and then selecting “Fit peak
between markers” for each region in turn.

Note that the fits are displayed graphically as well. To remove the fit from the spectrum select the “Hide
the fits” option from the ROI menu.

4.8 Help menu

Figure 8: Part of the main window of the viewer program showing the help menu.
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The “Help” menu has only one option “About”, which pops up a window with the keyboard shortcuts for
the various options.

MCA viewer version 4-5

compiled Tue Mar 24 14:06:52 CET 2009 on thelma-fp

c© Nigel Warr, Institut für Kernphysik, Universität zu Köln 2006

To set markers:

1) Left button down at left of region

2) Move to right of region holding left button down

3) Release left button

Keyboard shortcuts:

Backspace - remove fits from display

Home - show whole spectrum

Cursor left - scroll left

Cursor right - scroll left

Cursor up - zoom in

Cursor down - zoom out

CTRL-O - Open a spectrum

CTRL-W - Close spectrum

CTRL-S - Save spectrum as...

0...9 - Set autoscaling

A - toggle Autoscale

C - Calibrate

E - set Energy limits

F - Fit a peak between markers

H - show this help message

I - Integrate spectrum between markers

L - toggle log/lin representation for y-axis

O - Operations on spectra (+/-/*)

Q - Quit

R - set Region of interest between markers

S - Save spectrum

U - toggle autoUpdate

X - set X limits

Y - set Y limits

Z - Zoom between markers

Print - Copy image to clipboard

4.9 Calibration

Peak positions etc. in channels are not usually very useful, so it is necessary to calibrate the spectrum. This
is done by selecting the “Calibrate spectrum” option in the spectrum menu (see section 4.6) which pops up
the calibration window.

This window has three columns for channel, energy in keV and calculated energy. The user enters two or
more pairs of channel and energy values and the program calculates the appropriate calibration coefficients:
offset, slope and quadratic term, according to:

energy = offset + slope × channel + quadratic× (channel)2 (1)

These three terms are then displayed in the box below the table. Note that you can change these values
explicitly, or enter new values.

This calibration is also used to evaluate the calculated energies in the third column. In this way, if you have
enter several peaks, you can enter two that you are sure of, and use the calculated energies for the other
peaks to help identify them correctly.

Clicking on “OK” sets these calibration coefficients and closes the window.
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Figure 9: The calibration window.

Clicking on “Cancel” closes the window without changing the calibration coefficients.

Clicking on “Clear” clears all the entries from the table.

If you have already defined regions of interest around your peaks, it is useful to be able to use them to
determine the channels. This is done by clicking on “Read from ROIs”, which sets the entries in the channel
column to the centroids of the ROIs, leaving the energy column unchanged.

In the example shown here, there were lots of ROIs defined on the important peaks and then “Read from
ROIs” was clicked. Then the literature values for the energies of two of the peaks were given. The widget
has calculated the energies of the remaining peaks as well as the coefficients.
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4.10 Log window

Figure 10: The log window showing the results of three fits. Note that the colours are inverted.

Whenever you fit a peak, integrate between limits or click on the spectrum with the middle or right mouse
button, a message is added to the log window. If this window is not visible, it will be popped up.

The contents of the window can be cleared with the “Clear” button and the window can be hidden with the
“Hide” button.

There are four values of the full width at half maximum (FWHM). The first two are (in channels and energy)
assuming just a Gaussian fit. The other two incorporate the tail function used by the program tv. Note that
for this tail function a large number for left or right tail means there is little tailing!

4.11 Operations window

The operations window is a table of spectra, each of which has a “remove” button and a factor. You can
select one of the spectra currently loaded from the tab. The “Another spectrum” button at the bottom adds
another line to the list. When you click on “OK”, each spectrum is added after multiplication by the factor
into a new spectrum, which is then displayed.
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Figure 11: The operations window showing the operation of subtracting half the second spectrum from the
first.
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